New Tools to Teach CCNA: Packet Tracer v4.0
Goal of PTv4 Session

- Acquaint you with PTv4 so that you can begin
  - Using PTv4 in your classroom
  - Distributing PTv4 to your students for their use at home
What is Packet Tracer?

- Simulation software
- Useful for lectures, group and individual labs, homework, and competitions
Why use Packet Tracer?

• Teach complex CCNA-level networking concepts
• Design, build, configure and troubleshoot networks using virtual equipment
• Demonstrate technologies and configurations
• Supplement classroom equipment
• Empower students to explore concepts, conduct experiments, and test their understanding
PTv4 Session

- Overview of the GUI
- Create and arrange devices
- Configure devices
- Basics of simulation mode
- Simulation mode scenarios
- PDU information & challenge mode
- Activity Wizard
Overview of the GUI
Use the **File** menu to access “New”, “Open” and “Save” commands as well as the “Activity Wizard.”

Setting Preferences can be done from the **Options** menu.

Access extensive help files from the **Help** menu.

The **Toolbar** buttons can also be used to access all the File menu commands.
Click on the “i” to add a description to this network.

Help can also be accessed by clicking on the “?”
The Common Tools bar includes:

- **Select** tool for selecting
- **Move** tool for moving the entire topology
- **Note** tool for adding notes anywhere on the topology
- **Delete** tool for removing devices and links
Overview of the GUI

The Common Tools tool bar includes:

- **Inspect** tool for viewing device tables
- **Simple PDU** tool to create quick pings
- **Complex PDU** tool to customize packet type
Overview of the GUI

You can change the background with this button.
The **Device-Type Selection Box** is used to select the type of device or links you wish to create.

Then select the specific device you want in this window.

The **PDU List Window** allows you to create and delete different scenarios.
Overview of the GUI

Click here to switch to the Physical Workspace

Click here to switch to Simulation Mode.
Creating & Arranging Devices
Creating & Arranging Devices

To create a device:

1. Click the Select tool, if necessary.
2. Choose a device type.
3. Choose a device.
Creating & Arranging Devices

To create a device:

1. Click the Select tool, if necessary.
2. Choose a device type.
3. Choose a device.
4. Click in the topology.
Creating & Arranging Devices

A Few Tips:

You can create multiple instances of the same device by holding down the **CTRL** key.

Cancel creating a device by clicking on it again or another tool. Also, the **ESC** key will cancel any action.

Multiple devices can be selected at one time using the select tool and dragging a box around the desired devices.
Configuring Devices
Clicking on a device brings up its configuration window.

A device may require a module before you can configure it.

The 2620XM needs a WIC before you can connect a serial cable.
Adding or Removing Modules

1. Device must be off before adding or removing modules.

2. Click on an appropriate WIC module and drag it into an available slot on the device.

A brief description of the module is shown here.

A picture of the module is shown here.
1. To connect two router serial interfaces choose the DCE connection.

2. Then click on the router that will be the DCE side of the link.
Choose the interface.
Click on the other router and choose an interface.

The connection type you chose has a **Cancel** icon. Click it to cancel this connection type.
You can just float your mouse over the link to see the interface names and which side is DCE.

You can turn on the interface labels permanently under Options >> Preferences.
Hold down the **CTRL** key when selecting a device to add more than one instance of that device.
Connections can be made automatically by choosing the connection type shown below.
Connecting Devices

Router links will be red or not active until you correctly configure the interfaces.

Links between switches and PCs will be active after STP converges.
Configuring Global Settings

1. To configure a device, click on it and then click the **Config** tab. Then click “Settings” under GLOBAL, if necessary.

2. Type hostname in both places; one for **Display Name** and one for **Hostname**.

3. Device name is updated in topology.

4. Equivalent IOS commands are shown here.

5. Erase or Save NVRAM here. You can also load a saved .txt file or export the current configs.
Configuring Interfaces

1. Click on an interface to configure it.

2. Enter the IP Address and Subnet Mask.

3. Activate the Interface.

4. IOS Commands are updated and the link light is now green.
Configuring Interfaces

Serial links have a **Clock Rate** setting.
1. From the **Config** tab, you can configure either Static or RIP routing.

2. Type the network address and click the **Add** button.

3. IOS commands are updated.
A router can also be configured from the command line by clicking on the CLI tab.
Click on a PC and then click on the **Config** tab to configure it.

Under GLOBAL Settings, you can change the PC Name and enter the gateway IP Address.
Click on FastEthernet under INTERFACE to configure the IP Address and Subnet Mask.
Configure All Interfaces and RIP Routing.
Configuring a PC

From the Desktop tab, you can access all the features of a PC device.
IP Configuration allows you to configure IP addressing or use DHCP.
Configuring a PC

Dial-up interfaces are not yet supported in PT.
**Terminal** will bring up a Port Configuration window similar to HyperTerm and allow you to start a terminal session over a console connection.

You need a console connection to use **Terminal**.
Command Prompt will bring up a command line window from which you can issue DOS commands including ping, tracert, ipconfig and arp.
Simulation Mode Basics
1. Click on this tab to enter Simulation Mode.

2. The Simulation Panel will open where you can control details of the simulation.

3. To create a basic ping, click on the Simple PDU tool.

4. Click on the source.

5. Then click on the destination.

6. Choose which events you want simulated.

7. The simulation will start when you click either Auto Capture/Play or Capture/Forward.
If a device does not know the destination MAC, it will first send an ARP request before sending the ping packet.

When **Auto Capture/Play** is selected, you can speed up the animation with this slider.
Simulation Mode Basics

- Time since simulation began
- Eye indicates which Event is shown in topology.
- Protocol contained in this packet
- Click an Info box to show details of the packet at that hop.
- Device that sent this packet
- Device that currently has the packet
A timer at the bottom of the Event List window shows the total time that has elapsed since the beginning of the simulation.

**Reset Simulation** will clear the Event List so you can start the process over. However, device tables are not cleared. (ARP, MAC, routing, etc.)

**Constant Delay** can be turned off so that actual processing delay and propagation delay is added to the simulation.
1. You can open and close the Simulation Panel by clicking the “Event List” button.

2. Play Controls are still available.

3. Reset Network is a global power cycle feature. Make sure your configs are saved!
Simulation Mode Scenarios
Double-clicking on the title bar shown here will undock the Simulation Panel.
Once undocked, the panel can be moved so that you can see the pings in both the **Command Prompt** window as well as the **Simulation Panel**.
Simulation Mode Scenarios

You can pick the interface.

Select a wide variety of protocols.

Type in the destination IP. Clicking on the destination will fill in the IP address of the closest interface to the source.

Configure port numbers.

Choose to send one packet or send a packet every configured interval.

Click on the Complex PDU tool to configure more specifics for a packet.

NOTE: Setting the protocol for an application will help test ACL implementation on routers. However, PTv4 does not yet support services on PCs and servers, so any packet other than a ping or trace will fail at the destination.
You will get an empty Event List for each new scenario you create.

Highlight the Scenario name to type a new name.

Click the New button to create a new scenario.

Click on the i to add a description for this scenario.
Simulation Mode Scenarios

Click here to expand the PDU List Window.
Double click here to undock the **PDU List Window**.
The PDU List Window displays properties for each PDU created under this scenario.

Double click **Fire** to add a PDU to the Event List.

You can change the color of a PDU by double clicking on its color box.

You can Edit or Delete a PDU by double clicking here.
PDU Information & Challenge Mode
You can either click on the Info box for a specific PDU or click on the PDU in the topology window to bring up the PDU Information window.
The **OSI Model** tab shows the de-encapsulation/encapsulation process.

Clicking on a layer will display detailed information about decisions made at that layer.
Click on **Challenge Mode** to answer the question, “What is the device decision in this layer?”

Float over answers for more details.

Click **Hint** to get help.
The **Inbound and Outbound PDU Details** tabs display the details of PDU headers starting with Layer 2 at the top.

<table>
<thead>
<tr>
<th>Layer 2 Details</th>
<th>Layer 3 Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PREAMBLE</strong>: 1010 1010</td>
<td><strong>SRC MAC</strong>: 000C.F0C0.23E6</td>
</tr>
<tr>
<td><strong>DEST MAC</strong>: 0090.2164.D155</td>
<td><strong>ICMP</strong></td>
</tr>
<tr>
<td><strong>TYPE</strong>: 0x800</td>
<td><strong>Captured to</strong>: 0.002 s</td>
</tr>
<tr>
<td><strong>DATA (VARIABLE LENGTH)</strong></td>
<td><strong>Type</strong>:</td>
</tr>
</tbody>
</table>
| **FCS**: 0x0 | **ICMP** | | }

**IP**

<table>
<thead>
<tr>
<th>Layer 3 Details</th>
<th>Layer 4 Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong>: 0x0</td>
<td><strong>TYPE</strong>: 0x8</td>
</tr>
<tr>
<td><strong>0x0 FRAG OFFSET</strong>: 0x0</td>
<td><strong>CODE</strong>: 0x0</td>
</tr>
<tr>
<td><strong>TTL</strong>: 32</td>
<td><strong>CHECKSUM</strong></td>
</tr>
</tbody>
</table>
| **PRO**: 0x1 | | }

**ICMP**

<table>
<thead>
<tr>
<th>Layer 4 Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SOURCE</strong>:</td>
</tr>
<tr>
<td><strong>OPT</strong>: 0x0</td>
</tr>
<tr>
<td><strong>DST</strong>: 192.168.3.1</td>
</tr>
</tbody>
</table>
Activity Wizard
Use the **Activity Wizard** to create an activity.

Activity Wizard can be accessed from the File menu, from the tool bar, or with **Ctrl+W**.
We are going to use this topology as the answer network, so we answer “Yes”.
Welcome to the Activity Wizard!

The Activity Wizard is an assessment tool that allows you to create detailed networking scenarios for other users. The typical sequence in making an activity is as follows:

1) Create the answer network and set the assessment items.
2) Create the initial network, which will be the user’s starting point. A blank initial network may also be used.
3) Put constraints on the user’s ability to use certain features during the activity.
4) Write a clear set of instructions for the activity.
5) Password-protect the activity to prevent unauthorized changes to activity parameters.
6) Save the activity.

Please refer to the Activity Wizard help files for more detailed information.

The **Welcome** screen briefly describes the steps for making your activity.

There are no noticeable differences between PTv32 and PTv4 **Activity Wizards**
The Instructions screen provides a place where you can list the steps needed to complete this activity. The text can be simple, like shown here.
You can also use most basic HTML tags to format your Instructions, like shown here.

Copying code from an HTML editor works well!
Activity Wizard

Instructions:
Use the text field below to enter the instructions for this activity. The text field supports a limited number of HTML tags. For a complete list of the tags, please refer to the help files.

Step 1: Configure routers and hosts with correct IP addressing

- The table below shows the addressing scheme. All devices are using a /24 mask. Don't forget to configure the default gateway.

<table>
<thead>
<tr>
<th>Device</th>
<th>Interface</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>GAD</td>
<td>Fa0/0</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td></td>
<td>S0/0 (DCE)</td>
<td>192.168.2.1</td>
</tr>
<tr>
<td>BHM</td>
<td>S0/0</td>
<td>192.168.2.2</td>
</tr>
<tr>
<td></td>
<td>Fa0/0</td>
<td>192.168.3.1</td>
</tr>
<tr>
<td>HostA</td>
<td>NIC</td>
<td>192.168.1.2</td>
</tr>
<tr>
<td>HostB</td>
<td>NIC</td>
<td>192.168.3.2</td>
</tr>
</tbody>
</table>

Step 2: Configure RIP routing

- Configure GAD and BHM to advertise all directly connected networks with RIP as the routing protocol
- Verify both routers have complete routing tables with the `show ip route` command.

Click Preview as HTML to verify your coding.
The **Answer Network** screen allows you to customize the activity’s answer network, assessment options, and timer settings.

You can view and modify the answer network at any time by clicking here.

You can import a different answer network from an existing .pkt file or export the current answer network to a .pkt file.
Under “Assessment Options” you can choose which categories you wish to assess.

Under “Assessment Items” you can specify exactly which items you want to assess.
Under “Time Settings” you can have PT track how much time has elapsed since the activity was started or make this a timed activity. You can also simply turn the timer off by choosing “None”. The default is “Time Elapsed”.
The “Show Initial Network” button will display an empty topology, which means the student will start from scratch. Use the “Copy from Answer Network” button to copy the answer network to the initial network. Then click on “Show Initial Network” button and adjust the initial network so that the assessed items are missing.

You can import a different initial network from an existing .pkt file or export the current initial network to a .pkt file.

The Initial Network screen allows you to set up the initial network and lock certain options within PT.
Under “Set Locking Options”, you can specify which features are not accessible within the activity. Check items you want locked.
The Password screen allows you to set a case-sensitive password.

Click Test Activity to make sure the activity performs as intended.
The **Test Activity** wizard cap reminds you that you are testing the activity. Click on it to exit testing.

The **Instructions** window cannot be closed or minimized. However, you can make it smaller by grabbing the bottom and dragging to resize.
Use the **Check Results** button at anytime to see how many of the assessed items have been completed so far.

Use the **Reset Activity** button to restart the activity.
When the student clicks **Check Results**, she can see exactly which assessment items have not yet been completed.
When satisfied with the activity, click the **Save** button. Save the file with an appropriate name in the directory of your choice. Note that the file extension for activities is `.pka`. 
To protect a .pka file from being saved after a student has configured it, set the properties to **Read-only**.
Q and A
Additional Resources

- Forum
- Embedded resources in “Saves” folder
- Help and tutorials
Packet Tracer Forum

Packet Tracer

Welcome to Packet Tracer 4.0. Packet Tracer is a stand-alone, medium-fidelity simulation and visualization environment designed for networking novices to design, configure, and troubleshoot CCNA-level networks, as well as show the fundamental concepts of data propagation and filtering through network devices. More

Packet Tracer 4.0 FAQs
Packet Tracer 4.0 Video (Windows Media)
Packet Tracer 4.0 Video (QuickTime)
Packet Tracer 4.0 Standalone Tutorial Program 55MB, allow time for download
Download Packet Tracer 4.0 47MB, allow time for download

Due to the high demand for Packet Tracer, we are experiencing an extremely high download volume. If you encounter an error message "NoHostMemory" please try back later.

Discussion Title | Last Post | Total | New
--- | --- | --- | ---
New Packet Tracer 4.0 | Jul 07, 2006 | 10 | 10
New Error Download Packet Tracer 4.0 | Jun 26, 2006 | 11 | 11
New Packet Tracer 4.0 Questions | Jun 22, 2006 | 8 | 8
New Packet Tracer 3.2 | Jun 20, 2006 | 214 | 125
New Downloads | Jun 20, 2006 | 13 | 13
Embedded Instructional Resources

![Image of a file explorer window showing a folder named 'Packet Tracer 4.0\saves\CCNA1\ConceptBuilder_HubVsSwitch' with files such as 'HubVsSwitch_CoverSheet.doc', 'HubVsSwitch_Handout.doc', 'HubVsSwitch_Solution.doc', 'HubVsSwitch.pka', and 'HubVsSwitch.pkt' listed.]
Help and Tutorials

Packet Tracer 4.0

Introduction
What's New
Program Usage

Getting Started
Tutorials
Workspace Basics
Logical
Workspace Physical
Workspace
Moving Devices
Wireless Devices
Special Notes

Operating Modes
Realtime Mode
Simulation Mode
PDU Information
Scenarios
Complex PDUs
Special Notes

Connections / Links
Devices &

Using the Help Files
The help files are designed to familiarize users with the Packet Tracer 4.0 interface, functions, and features. Although they can be used as a reference guide, the pages are meant to be read in order (especially the sections presented at the beginning of this guide). Annotated screenshots are used to aid your understanding, and important notes or tips are presented in tip boxes like the following:

If you are a first-time user, please read the help files in order.